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1 Introduction 
The manual in your hands (or on your screen) covers all the administrative functions 
required to administer users, roles, and user configurations for the Traffic Studio 
application. 

 

Administrators have “PowerUser” access in Traffic Studio. The top access, “SuperUser”, 
is normally only available to Consat personnel and provides functionality for complex 
system setup. 

Normally, Consat will perform all advanced system configurations, setting up a basic set 
of user roles with configurations that you as administrator (PowerUser) can then edit, 
copy and add users to. Consat normally also configure tool placement and define how 
each tool window is presented in the Application etc. 

 

 

1.1 Default Role Configuration (Performed by Consat) 

As stated, a Consat Telematics TM (Traffic Monitoring) system is normally delivered with 
several pre-defined user roles, set up by Consat to suit your needs 

To simplify the specification of these roles, the list below explains the basic functions that 
can be specified by you for each role. 

The delivered roles can then be edited/copied etc. by you as the system administrator to 
suit your changing needs. 

 

Role Functionality Description 

User log-in 
inside/outside 
domain 

Users placed outside the system domain log in through a web 
service. The path is provided by Consat (specified in dialogue 
with the customer). 

Local Configuration 
File write 
functionality 

The local configuration file in each Traffic Studio computer will 
normally work as a fallback whenever the central configuration 
database cannot be accessed.  

If you specify that changes to the configuration are to be saved 
in this local file, the fallback configuration can be kept up to date 
(follow the configuration specified in the database), but it can 
also be “damaged” by faulty configuration. 

On the other hand, if you specify that changes in the 
configuration will not be written to the local file, it will work as a 
“factory” default configuration, providing tamper-protected basic 
functionality when the configuration database cannot be 
accessed. 

Prevent Specific 
Configuration 
Changes 

As a complement/alternative to write-protecting the local 
configuration file, specific settings in the applications can be 
protected from configuration changes. This function is extremely 
flexible as any part of the application configuration can be write-
protected. Discuss your needs with Consat if you need to prevent 
changes to specific functions, tools, etc. 
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Role Functionality Description 

Toolset/role Each pre-set role will have a basic tool-set included by default 
(selected from the list of TrafficStudio tools ordered by the 
customer). 

As an administrator, you can then add or remove tools from the 
role as needed, or copy the role and make changes in the toolset, 
see the following chapter for how to change the toolset in a 
configuration. 

Individual tool 
configuration in the 
application 
framework 

Each tool placement and basic framework functionality can be 
configured by Consat to suit your needs. The following functions 
can be set for each tool: 

• Tool placement (left, bottom, top application window- or 
separate floating tool window. Note that some tools need to 
be placed in rectangular “vertical”/”horizontal” tool windows 
for the user interface to function properly.) 

• Tool auto start (automatically activated, in configured 
position, when the application is started) 

• Display placement when two displays are used: 
Primary/Secondary display 

• Tool Close button (in the tool tab) enabled/disabled. (If 
needed, crucial tools can be prevented from being closed by 
the user, for instance, Voice communication or other 
important communication tools may be configured this way 
to prevent missed messages, etc.) 
 

• If needed, the application can also be configured to start 
with one tool in full-screen mode. For instance, if the 
workstation is to be used for one specific task. 

 

Maximized 
Application Window 

The TrafficStudio application can be configured to open in the 
maximized mode in Windows. 

Application log The number of user roles applied to the user. 
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1.2 Configuration applied to Roles, Users, and Computers 

In Traffic Studio, a configuration is mainly applied to user roles, but in some cases, 
individual users and individual computers can have specific configurations. (Note: A user 
may be assigned several roles and may have access to multiple configurations, selected 
when he/she login to the application.) 

 

Here, we will show you how to administer users and user roles (chapter 2) and how to 
manage configurations applied to these users, roles, and individual computers (chapters 3 
and 4). 
 

1.3 Basic Functionality and Workflow 

Configuring Traffic Studio includes the following basic steps: 

1. Define base roles and their pre-set role functionality together with Consat (see 
section 1.1 above) 

2. Create users and apply roles to users, see chapter 2 

 

If needed, create new roles based on the pre-defined roles, see chapter 2 

1. Administer/edit configurations applied to roles. 

2. If needed: Edit individual user/computer configurations: (Tool setup etc.) 
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2 Administer Users and User Roles 
To administer users and roles, the User Manager Traffic Studio tool is available to you as 
PowerUser. Depending on your default roles you will find the tool in the regular Tool 
menu. 

 

Externally created Users and Groups (Roles) 
In some systems, users and groups (roles) can also be defined outside the application if 
such a workflow is preferred. See the Window’s user manual for more information about 
how to set up and edit users and groups (roles). Note that the User manager tool cannot 
view/edit these users/groups. 

 

2.1 User Manager: Tool Overview 

The User Manager tool lists users and user roles on two separate tabs. On each tab, you 
will find function buttons for adding, editing, and removing users and roles, respectively. 

When you select a user/role, the edit section below shows the available details for this 
item. 
 

• If you are an administrator handling multiple companies, a top company filter lets you 
list either the users/roles in all companies – or the users/roles of a selected company. 
 

• If you are a Power User without access to some roles, these will be greyed out and 
highlighted with a lock symbol in the role checkbox list in the details section. You 
cannot add/remove users from roles you do not have access to/belong to. 
 

• The Users tab also includes filters for focusing the list, these filters are described 
below. 
 

 

 

 

  

Company Filter 
Users Tab User Roles Tab 

User role and free text filters. (View only 
users with selected roles and/or cells 
matching the free text content) 
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The Company Filter 
Use the company filter to either list the users of all the companies you administer or only 
cover a selected company. Open the menu by clicking on the menu button and click to 
select one of the available items in the list. The “Administration company” includes all 
companies in your system. 
 

 

  

To edit user details, including password and 
assigned user roles (menu), click on the 
corresponding row. A details/edit section 
below the list will show. 
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2.2 Administer User Roles (User Roles Tab) 

If the pre-defined set of roles supplied by Consat is insufficient to cover your needs, you 
can edit or copy and then edit any of the pre-set roles to set up the roles you need. 

As users are to be assigned different roles, you normally first define the roles that are to 
be available in your system. This is a simple naming procedure. 

The user roles tab contains a role list with a separate description column (for describing 
the role). 
 

• Note: So-called Role Grants can allow the users with that role to access specific 
functionality/data, see below. 

• Note: If you are not a Super User, only the roles you belong to will be presented in the 
list. 

• Note: If you are not a Super User and create a new role, you will automatically be 
added to that role (making it visible in the list) 
 

  

 

  

Click on a row to edit role name 
and/or description in the separate 
details field. 
 
A Role Grants section enables 
configuration of available 
functionality/access for the role. 
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Role Grants 
Role Grants set basic functionality/access for the user role. 
You can allow the role to download CCTV media (using the CCTV Media tool), administer 
traffic information for all companies and assign vehicles to other companies' journeys (for 
reinforcement, etc.). Checkboxes to include that functionality. 

Traffic deviations can be publicized over multiple channels (to multiple receivers). In the 
Publication channels menu, you configure which channels are to be available to the role. 

 

 

 

Add User Role 
 If a row is selected, click on Esc to deselect it. Click on the Add button to open a new 

empty role details field. 
 
 
 
 

 Enter the new role name (mandatory) and, optionally, a descriptive text in the 
description field. 
 
If applicable check the appropriate boxes in the Role Grants section (see description 
above). 
 

 
 

 Click on the Save button to save the role. 
 
 
  

 

Edit User Role 
 Click on a role (row) to select it. 

 Edit the name/description/role grants. 

 Click on the Save button to save your changes. 
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Remove User Role 
 Click on a role (row) to select it. 

 Click on the Remove button. 

 

2.3 Administer Users (Users tab) 

On the Users tab, you will find all users created by the User Manager tool. You can add or 
remove users and change names, settings, role(s), etc. 

  

Column description 

Header Description 

Username User name 

Employee number Employee number. 

Given Name The user's first name(s) 

Surname The users' surname 

Description Descriptive text 

Number of roles The number of user roles applied to the user. 
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The User Roles Filter 
Use the user roles filter to only view users with certain user roles. 

 

 

Free Text Filter 
Use the free text filter to narrow down the user list to only include users with at least one 
matching cell (these are highlighted in the list). 

 

 

  

 

Add User (and assign roles) 
 Click on the Add button to open a new, empty, details field. 

 

 Enter user details. The fields highlighted with “*” are mandatory. 

 
 

Open the filter menu by clicking on the button. In parenthesis: 
(The number of currently selected user roles/total number of roles) 

Enter text/numbers: The list will be filtered to 
only include users with at least one matching 
cell. 
 
 
 
 

Filter effect: Displayed users/total number 
 
 
 
 



Traffic Studio Administrators Reference Manual 
 

Ver.25.7.(X)   15 /91  

 

 

 

 
 

 

Privileged 

 In the user roles menu, check the roles the user is to have. 

 
 

 If the user is to have PowerUser (administrator) access, check the PowerUser 
checkbox 
 

 Click on the Save button to save the user 
 
 
 

Edit User 
 Select the user in the list by clicking on the corresponding row. 

 

 In the edit field below, change the information/settings that are to be updated. 
 

 Click on the Save button to save the changes. 
 

Remove User 
 Select the user in the list by clicking on the corresponding row. 

 Click on the Remove button, the user will be removed immediately (no confirmation 
dialogue). 
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3 Administer Configurations 
File > Setup > Configuration Manager 

 

Individual Traffic Studio Configurations are administered with the Configuration Manager, 
a floating configuration window available to power users. 

 

Note: Super Users have access to more functionality in this tool for viewing and 
comparing configurations in detail. See the Super User Manual for more information. 

 

Here, you get an overview of all configurations in the system. Below the configurations 
list, you will find function buttons for: 
 

 Loading a selected configuration into Traffic Studio (for viewing details, and editing) 

 Saving the currently selected/loaded and edited configuration – to the same target. 

 Copying a configuration (saving a loaded configuration to another target, overwriting 
the current configuration) 

 Removing/deleting a selected configuration 
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3.1 Configuration Manager Window: Overview 

The floating Configuration Manager lists all individual configurations in your system. 

Like other list views, the Configuration Manager list can be filtered using a free text filter, a 
type filter, and sorted by any column to allow focusing on the information you need. 

 

 

 

  

 

 

 

 

Header Description 

Type The symbol indicates the configuration 
target/user: 

 - Role 

 - User (logged in as role…) 

 - Computer (logged in as role…) 

User User Name. 

Function buttons for loading the Traffic Studio application with a 
selected configuration, for saving the currently loaded configuration to 
the same or another target and removing (deleting) a selected 
configuration. The Import/Export buttons lets you import or export a 
configuration from/to a file. 

In the configuration details section, you view details for the 
selected configuration. 
Here you also select a user/role/computer configuration to 
save the currently loaded configuration to. 

Free Text Filter: Filter the configuration list 
to only include rows with at least one 
matching cell. 

Click on a column header to 
sort the list by the content 
in that column. Click again 
on the same header to sort 
in reverse order. Icons differentiate role, 

user and computer 
configurations 

Use the type filter to only view 
configuration types of interest: 
Groups/Users/Computer. 
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Header Description 

Role Role Name 

Computer Computer Name 

Language Default language (languages depending on 
system) 

Time Zone Available time zones, selected at login. 
 
If no time zone is selected in the menu/displayed 
in the column, all system time zones will be 
available to the user at login. 

Modified Time Time Stamp, showing last change 

ID Configuration ID 
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3.2 Loading Configurations into Traffic Studio (for 
viewing/editing/copying) 

Most editing of a configuration is performed within Traffic Studio with that specific 
configuration loaded. To make changes to a configuration you first use Configuration 
Manager to load the configuration in Traffic Studio. 

The Traffic Studio application window will load the complete configuration – all tools, 
settings, etc. so that you can make any changes in the various configuration menus in the 
Setup menu– and then save it with the Save button in the Configuration Manager, see the 
following page. 

 

When Traffic Studio is loaded with another configuration than your own, the top and 
bottom sections of the application window will be highlighted blue and the loaded 
configuration will show in the lower right corner of the application, see the image below. 

 

 

 

 

 

  

To load a configuration into Traffic Studio, select it in the Configuration Manager window and click on the 
Load button. 
Traffic Studio will load the selected configuration. The Traffic Studio window will now be highlighted blue 
to show that another configuration than your own has been loaded. The loaded configuration will show in 
the bottom user row (see details window). 

The user profile/configuration field shows both your configuration (to the 
left) and the loaded configuration, to the right. 
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3.3 Load, View, and Edit Configuration 

To view, and maybe edit a configuration in the list, do this: 

 

 Select the configuration you want to view/edit (click on the corresponding row). 

 Click on the Load button. 
 
The Traffic Studio window will load the selected configuration. To highlight that a 
configuration other than the one you logged in as is loaded, the window gets blue 
top and bottom bars. In the configuration manager window, the icon of the loaded 
configuration is also highlighted blue. 
 
You can proceed to connect the application to a configured system and check the 
toolset etc. to verify that the configuration is correct. Disconnect to open the setup 
menu to make changes in the configuration, see the example below. 
 

 

 

 If needed, edit the configuration using the available sub-menus in the Setup menu  
(see chapter 4). 
 

 Save any changes by clicking on the Save button in the Configuration Manager. 
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3.4 Copy a Configuration to another User/Role/Computer 

As an administrator, creating a “new” configuration means copying an existing 
configuration and saving it to another “location”: A “user logged in as selected role”, to 
another role or to a “computer logged in as selected role”, replacing that existing 
configuration. You can then load and edit the copied configuration to make it unique. 

 

• In a new system, setting up configurations/roles normally start with a default 
configuration (created by Consat) that is then copied and edited to make all the 
desired roles/configurations. 
 

• Note: Make a habit of separating “copying” configurations and editing configurations, 
so as not to save unwanted changes to the original configuration by mistake. First 
“copy” the configuration and then load, edit and save the copy. 
 
 

 Load the Role or User configuration you want to “copy” by selecting (clicking on the 
row) and then clicking on the Load button. 
 

 

 

 Click on the Add New button. The details field under the list is cleared. 
 

 
 

 Select either a Role, a User, and a Role (user logged in as role) or a Computer and a 
Role (computer logged in as role) in the menus to receive the configuration. 

 Select a default language and the time zone(s) that are to be available upon login. (If 
no time zone is selected in the menu, all system time zones will be available to the 
user at login.) 
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 Click on Save to save the configuration to the selected target. 

 

3.5 Import Configuration from File 

 Load the Role or User configuration you want to import the configuration to by 
selecting (clicking on the row) and then clicking on the Load button. The import and 
Export buttons become active. 

 Click on the Import button. A browse window opens. Navigate to the file, select it 
and click on “Import” to import the configuration to the selected role/user. 

 Click on Save to save your changes. 

 

3.6 Export Configuration to File 

 Load the Role or User configuration you want to export by selecting (clicking on the 
row) and then clicking on the Load button. The import and Export buttons become 
active. 

 Click on the Export button. A browse window opens. Navigate to the place you want 
to save the configuration file, select it and click on “Export” to create the file. 
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3.7 Remove Configuration 

To clean up the configuration list you can remove configurations. Of, course, this function 
is to be used with caution. 

 

 Select the configuration that is to be removed 

 

 Click on the Remove button – the configuration will be removed from the database 
immediately 
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4 Make changes to the loaded configuration 
As an administrator (PowerUser), you can change basic system functionality, the tools 
available in each (role) configuration, and also change the set-up of the individual tools. 

 

• When you load a role configuration you can configure basic system functionality and 
the available toolset for that role, as well as configure information presentation and the 
individual tools in the selected toolset. 

 

• When you load a user or computer configuration you can only configure the 
information set up in Traffic Studio and set up the individual tools. The top Systems 
and Tool (Plug-in) Manager menu alternatives will be greyed out. 

 

 

 

 

  

1. Configure Basic System functions 
 

2. Select Tool Set 
 

3. Presentation Setup and Individual tool Setup 
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4.1 Set Basic System Functionality (Loaded Role) 

File > Setup > Systems>Edit Selected System 

 

As a PowerUser, you can configure basic presentation settings and configure read-only-
functionality for some system services, per role. This is performed in the System Definition 
window on two separate tabs: Appearance and Services. 

Open the System Definition window by selecting Systems in the Setup menu, this opens 
the Available Systems menu. Select the system you are to edit settings for and click on 
the Edit button to open the System Definition window, see below.  

 

 

 

Key Code 

 

  

Key Code 

Determines which functionality/tools will be 
available and which will be locked. The code is 
supplied by Consat for each role and system. 
 
Click on the “?” button to view which 
tools/functions are available/locked, see 
following section. 
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View Available/Locked Functionality 
Click on the “?” button to open the Key Code window. Here, all tools and all key-code-
controlled functionality are listed. Locked tools/functions have locked symbols, see below. 

 

Appearance tab 

 

 

• After you have made changes, click on the Apply button to save.  

Locked Functions 

All non-available tools and functions 
are highlighted with lock symbols. 

 

Tip: Use the free text filter on top to 
quickly find a specific plug-in/tool in 
the list 

Vehicle Numbering 

Determine how the system addresses will be 
displayed. Each # represents a digit to be 
shown. 

E.g. ____#### means that the last four digits of 
the vehicle number will be displayed. 

Late prefix 

Display a + or a – when 
behind the timetable. 

Show Only Resource 
Vehicles 

Check to only show (Real 
Time) vehicles included in the 
system vehicle database. 
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Services Tab (Power User) 

 

 
 

• You can check the connections to the services used in the system by clicking on the 
Test Connections button. A green hatch by each service will show an OK connection, 
red crosses will indicate missing connections, impairing system functionality. 
 

• After you have made changes, click on the Apply button to save. 

 

  

Read Only 

Check to make the service read only 
(for the loaded role), letting users 
only view information not 
create/save/publish/assign. 

 

Currently, you can set Assignments, 
Events (Event: Configuration) and 
Traffic Information (the “Multimedia” 
Service) to read only mode. 
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4.2 Define Toolset (Loaded Role) 

File > Setup > Tool (Plug-in) Manager 

 

In this window, you select the plug-ins (containing Traffic Studio tools) to be available to 
all users of the loaded Role. 

You can add, remove and save your choices by using the buttons at the bottom of the 
window. 

The tools are displayed with their [rather technical] plug-in names in the Available plugin 
window. 

 

 

 

 

 

 

 

Use Paths 

If the box is ticked, you can 
select a tool centrally hosted 
on a server. 

 

If the box is not ticked, the 
plug-in is selected from the 
local application folder.  

 

Add 

Add a tool you have 
selected in the Available 
list to the role toolset 
(the Selected list). 

Delete 

Remove (selected) 
tool(s) from the role 
toolset. I.e. move it/them 
from the Selected list to 
the Available list. 

Ok  

Save the changes and 
close the window. 

 

Cancel 

Cancel the changes and 
close the window 
without saving. 

Selected 

A list of all selected tools that 
are available when the 
application is running. The tools 
in these plug-ins are the role 
toolset. 

Available 

A list of all the remaining tools, 
which are not available when the 
application is running, but could 
be added.  

Content 

View the tools/report in 
a selected plug-in, see 
next page. 
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View tools in plug-in 
A plug-in may contain many tools or reports. To view the specific tools (with their proper 
tool names) in a listed plug-in, select the plug-in in the list and click on “Content”, see 
below. The tools are listed in a separate Content window. 
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4.3 Configure Tooltips and Labels 

File > Setup > Tooltips and Labels 

 

• See the Reference Manual. 

4.4 Configure Vehicle Presentation 

File > Setup > Vehicle Presentation 

 

• See the Reference Manual. 

 

4.5 Configure Line Groups 

File > Setup > Vehicle presentation > Line groups 

Add, remove, and edit line groups used for filtering the presentation in Traffic Studio. 

 

 
 
 

 

Selected Tab 
List of all the selected lines. 

 

Selection Tab 
List all the lines, with a checkbox for each, where you select which ones will be included in 
the line group. 

 

System 

Selection of the central system. Clock on ”Load” if a 
system is not loaded. 

 

Add / Remove 

Add or remove a group. See below for the 
description on how to perform both actions. 

 

Group Name 

Selection of the group. This field will become 
empty if you click on Add to allow you to type 
in the name of the new group. 

Save 

Save the changes and 
close the window. 

 

Cancel 

Cancel the changes made and 
close the window. 

 

Tabs 

Selected / Selection / Regex 
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Filter (Regex Tab) 
The user can select which lines to include in the line group with the help of a filter. These 
lines are added to the manually selected ones under the Selected tab. 

 

The filter uses the Regular Expression format, which allows you to define line groups with 
logical expressions/functions in four different categories, each of them related to the four 
columns in the Selected tab, i.e. Line, Description, External ID, and Internal ID. 

Many columns can be combined to narrow down the selection. Only the lines fulfilling the 
user’s criteria will be selected and shown in the Selected tab. 

 

Regular Expression: Special Characters 

Special characters are optional. Without them, all the lines fulfilling the content entered by 
the user will be selected. 

 

Two practical examples: 

 

• You write 17 in the Line field. All the lines with a 17 in their names will be included in the 
line group, e.g. 17, 117, and 0171. 

• You write Maple in the Description field. All the lines, which have this word somewhere 
in their description, will be included in the line group. 

Regular Expression consists of many functions that allow, in combination with the normal 
fields, the creation of complex and advanced filters. The table below lists the most 
common special characters along with examples. 

 

 

Function Description 

[  ]  Include the strings containing a part of the content between the 
brackets. 
 

Practical example 

You want to include all the lines, which have the numbers 1, 2, or 6 in 
the line field. You enter [126]. 

You can also use intervals. If you want to include all lines with the 
numbers 1 to 5, you can enter [1-5]. 

^X
Identify the first element in the string. Using ^X means that all the 
strings beginning with X will be included. 
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Function Description 

^
X 

Practical example 

You want to include all the lines with an internal ID starting with 4. You 
enter ^4 in the Internal ID’s field. 

Define a Group 

 Select a system and click on Load (if the system is not already selected). 

 Click on Add 

 Name the new group under Group name. 

 The button Add will change to Save. Click on it to save the new group. 

 Select your lines by their checkbox, either via the Selection or the Regex tabs. 

 Save the new group or save the changes and close the window by clicking on Save. 

 

Edit a Group 

 Select a system and click on Load (if the system is not already selected). 

 Select a group under Group name. 

 Tick to add a line or tick off to remove a line. 

 Continue to edit other groups or save the changes and close the window by clicking 
on Save in the bottom right corner of the window. 

 

Remove a Group 

 Select a system and click on Load (if the system is not already selected). 

 Select a group in the Group name’s menu. 

 Click on Remove. 
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5 Power User/Administrator Functions, Tools 
Traffic Studio includes a few tools that can be configured to be available for regular users 
but are mostly intended for advanced/power users. To “unclutter” the Reference Manual, 
we have placed the tool descriptions here in the Administrators Manual. 

 

5.1 My Report Sheet Templates 

This simple tool lists all the report sheet templates imported into your system. 

The templates are used for handling questions and related answer alternatives presented 
both in pre-, and post-op check forms and for configuring Deviations, including trigger 
thresholds. See the default template examples below: 

 

 
 
When a Deviation is triggered in a vehicle the driver is presented with a (template-
specified) form for explaining the cause of the deviation. The Deviations tool in TS also 
provides the traffic controller with the same “cause” menu where traffic controllers can 
change/correct the reported cause of a deviation. 

 

• Note: The default/”clean” template files for deviations and checks, respectively, are 
available in the system portal. To configure deviation/pre-/post-op checks, fill in the 
document(s) with the needed templates and import them as resources into CTS 
using the Configuration Manager web application. See the separate Configuration 
Manager manual for how to do this. 
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Overview 
The tool lists all imported templates. Use the filter section (described below) to view only 
templates of interest. 

Note: The list will also include any waste-handling-related forms in the system. These are 
more complex and are not imported as excel files thru the CM. 

 

 

 

 

 

Name Description 

Name Template/form name 

Deviation Type 

Type of deviation (deviation template), or “pre/post-op check”. 

Note: “Deviations (customizable) is the deviation type for deviations 
created by the New Deviation tool. 

Company Company/Operator 

Category Type of template/form (for Deviations (customizable), the deviation 
category/base node in the selection tree) 

Priority Template priority (not to be confused with deviation or event priority 
in the system). 

Questions The number of questions in the template 
Note: For manually created deviations, this includes each expandable 
node, see the following section. 

Report Points The number of report points in a waste handling form. 

Last Update: A timestamp showing when the latest version of the template was 
imported into the system. 

ID Element ID 

Version Version number 

Filters 
Details (show/hide),  contents of 
selected template in list 
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Name Description 

Colours Configured colour (background, report form in driver interface), if 
any. 

Tooltip shows configured colour numerically. No box means no 
configured colour/default grey. 

 

 

 

Filter Section 

• If you have access to multiple companies, select the company whose templates you 
want to display in the top left menu. 

• Check the “Current version only” box to only view the templates in use. Also, see the 
section below. 

• Use the free text filter so find specific templates. 
 

 

 

Current/Non-Current Versions 
With the box “Current version only” unchecked, all versions of each template in the 
systems will be displayed. The current version is displayed with standard text but 
historical (non-current) versions are displayed in greyed-out italics. See below. 

 

 

 

 

  

Current Version 

Non-Current Version 
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Details 
This section shows the contents of the currently selected template in the list. Each report 
sheet template consists of one or more “questions” (in the left column) and related 
answers (in the right column). 

In Deviations triggered in the vehicles/centrally, the answers are the alternative causes of 
the related deviation presented to the driver /traffic controllers. 

 

• Note: Manually created deviations use templates in the same question-answers 
format to form a hierarchical selection tree where the user can select a specific 
deviation type and cause. (One deviation type is defined by one template.) See the 
next page. 

 

 

  

 

  

Configured (background) 
colour 

The question-answer 
hierarchical ”level” under the 
top nodes section. 
For manually created 
Deviations this indicates the 
hierarchical level of the 
question-answer sections. 
Making it easier to ”decipher” 
the template into the 
resulting selection tree.  

The type of entry (can be 
numerical, text, etc).  For 
Deviations ”choice” is used, 
with the corresponding 
choices in the right column. 
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Details: Report Sheet Templates for Manually Created Deviations 
For manually created deviations (of the type Deviations (Customizable), the templates 
form an hierarchial selection tree of deviations sorted into categories and causes for quick 
selection. 

 

 

• Every “base node” in the tree is a separate template (row in My Report Sheet 
templates). 
 

• The top level under the base node is described in the first “question-answers 
section”, and the next level is described in the following sections, and so on. See the 
example below. 
 

  

The selection tree in New Deviation, 
formed by the ”Deviations 
(Customizable)” templates. 
 
The base node ”Test custom…” in 
the tree is one template/row in the 
My report sheet templates tool. 
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• The form is flexible and not specifically designed for this use. Taken together, all such 
templates for a company will form a simple “Deviation -> Cause” tree that is used by 
the New Deviation tool for manually entering Deviations. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

In ”New Deviation”: One base node 
in the selection tree expanded. 
 
The first question-answers-section 
in the template describes this level. 

The next level (level 2) top node 
is expanded. The next question-
answer in the details section 
describes the alternatives under 
this node. 
 
The underlying nodes are listed 
in the following question-
answer-sections. 
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5.2 Deviation Templates 

 

Note: This tool/function is under development. 

 

• In the current version of CTS, generation of Driver Alarm deviations are supported with 
the use of Deviation templates. More deviations will be added in upcoming releases. 
 

Deviation Templates: Basic Functionality 

• Deviation templates allow you to set up how (based on your deviations 
configuration), specific Events and Warnings will generate deviations. 

 

• Templates “fill in” the created Deviation [window] based on the template contents. 

 

• Enter as few or as many templated items (menu selections/checked boxes) as you 
want. A template can produce an almost completed deviation form or maybe only 
check a single box (apart from defining the deviation). 

 

The Deviations Template Tool 
The Deviation Templates tool lists all deviation templates in use in your system. 

It allows you to create new templates, edit templates and delete templates. 
 

Each deviation template is configured using the same deviation tool window you use for 
creating/processing deviations in your system, and shows your configured sections menu 
items etc. You make selections in the standard deviation menus and check boxes to 
define your template. And then save your template. 
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How Deviation templates are applied to a generated deviation 
• Note: In the current release, the event/warning that generates a deviation is manually 

mapped to the name you give a template that you want to use to create the deviation, 
or the template ID. 

 
Contact Consat Telematics for assistance with mapping, when you have defined 
your templates. 
 

• Note: Currently, only a specific list of events/warnings use this deviation generation 
and configuration method. 
 
The events listed in the TS Event Configuration tool that can generate deviations use 
another way of configuring the resulting deviation. 
(These are configured with only the report sheet templates. See The Deviation chapter 
in the Reference manual and the My Report Sheet Templates here in this 
administrators manual for description.) 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tool Overview 
The Deviation Templates tool lists all your deviation templates w basic content presented. 
A “New Template” button opens a blank deviation template window, and quick menus 
allow you to edit or delete templates as needed. 

• Note: The configurable columns mirror those in the Deviations tool. Normally fewer 
columns will be of interest in a Template list. The columns unique to this tool are bold in 
the list below. 

 

Configuration 
File (xml):  
 
Connects triggered 
event to deviation 
template 

Generate deviation 
based on 
mapped/linked 
template 

Event/Warning X 
generated 

Deviation X, by 
Template Y 

Template Y: Specific menu selections/checked boxes applied. 

Your configured deviations (defined by report sheet 
templates) form the menu alternatives and checkbox 
items of the template window. 
 
The template content is based on the Custom 
Deviation report sheet templates imported and used 
in your system 
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Column Description 

ID Deviation ID 

Priority Set priority (if any), 1-5. Used for sorting and filtering the presentation to 
highlight the most important deviations. 

Template Name Template Name (freetext) 

Summary The configured “short description” of the deviation, that is also the 
deviation header in the deviation window. May include deviation, journey, 
journey start time, etc. 

Company The company driving the journey. Also, see the Company Filter description 
below. 

Line The line serviced by the journey on which the deviation was recorded 

Destination The journey destination 

Vehicle Vehicle number 

Driver The driver's name, if available. 

Place Location where the deviation occurred, if entered in free text. 

Block The block that includes the journey on which the deviation was recorded 

Journey The journey on which the deviation was recorded 

Stop Point The stop point where the deviation report was (first) triggered 

Calendar Day The date when the deviation report was triggered 

Planned Departure The planned departure time (from the indicated stop point on the indicated 
journey) 

Actual Time The recorded time of departure, (for automatic deviations: When the 
deviation was first triggered.) 

Report Time Stamp When the deviation report was created/sent 

Time Deviation The difference between the planned and the actual departure (for timetable 
deviations). 

Deviation The logged Deviation (specified in the bottom deviation menu in the 
deviation window): 
 

Deviation Type The logged deviation type (system dependent) Note: Manually created 
Deviations are of the type “Deviation (customizable)”. 

Category The category the deviation belongs to (specified in the top deviation menu 
in the deviation window). 
 

Cause The (currently selected) cause of the deviation, specified by traffic 
controller. 

Cause (driver) The cause of the deviation selected by driver (if available). Read only 
(default configuration). 
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Column Description 

Status Shows the deviation ticket status: Not set/Pending/In Progress/ 
Processed/Closed 

Action Card Shows if the deviation includes required actions. (Actions that need to be 
performed for the deviation to be closed). 

Comment Deviation comment (internal, not publicized). It is possible to enter/add 
to/edit the comment, see below. 

Note: A related Traffic Changes ticket including a disturbance and 
comment will export its comments to the affected deviation. 

Published Comment “External” comment included in publicized deviation. 

Consequences The (automatically/manually) selected consequences of the deviation, see 
the Deviation Window Consequences section(-s). 

Published 
timestamp 

When the deviation was published to 3:rd party. 

Published Email Email publication channels selected, see the Deviation Window 
Consequences section(-s). 

Published SMS SMS publication channel selected, see the Deviation Window 
Consequences section(-s). 

Required Action Checked required action, see the Deviation Window Consequences 
section(-s). 

Penalty Notation Checked penalty Notations, see the Deviation Window Consequences 
section(-s). 

Modified by User/Driver that (last) reported a cause of/reason for the deviation. 

When a deviation has been created by an event (like “journey incomplete”, 
this cell shows “Event Generator” as user/source. 

Modified time Timestamp showing when the deviation ticket was created/last changed. 

Assigned The user the deviation ticket is assigned to (if any) 

Assigned Time 
Stamp 

When the assign status was last changed 

Removed Checkbox (read only) shows if the deviation has been removed. Note: 
Deviations cannot be deleted only flagged as removed/“not valid”. Check 
the “Show Removed” filter to see all removed deviations. 

Source Where the deviation was created/triggered: Traffic Control/ Vehicle… 
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Edit Window 
The edit window works just like (and looks just like) the deviation window used for 
processing deviations. 

• The deviation template has two purposes: Defining the deviation (in the deviation 
section) and applying a base configuration for each generated deviation, in the other 
editable sections, if so desired. 

 

 

 

 

  

Your free text template 
name (give this to 
Consat for mapping). 

 

Deviation definition is 
mandatory: Select 
Category and 
Deviation. 

 

Use all other menus and checkboxes (if needed) 
to “pre-define” your deviation. The created 
deviation will have these default selections, 
which of course can be edited by the user 
processing the deviation. 
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Create new Deviation Template 

 Click the New button  

 In the Template window: Enter a free text template name. 

  

 Define the deviation in the Category-Deviation menu. This is the only mandatory 
selection.) 

  

 Enter other menus/check boxes as needed. 

 Click Save. 
 

Edit Deviation Template 
 Right-clik on a deviation remplate row, select “Edit”. 

 

 Change above described menus etc as needed. 

 Click Save. 
 

Delete Deviation template 
 Right-click on a deviation template row and select Remove. 

 

 Confirm removal in dialogue. 
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5.3 Traffic Changes: Create, Administer Templates 

If you are an administrator responsible for setting up and editing templates, you will find 
additional buttons and right-click menu alternatives in the template section. 

You can create and edit the template navigation tree, create and sort templates into these 
categories, and delete navigation tree items and templates. 
 

   

 

The Template Navigation Tree 
The templates are sorted and categorized in a Navigation tree (see description in the 
previous section) 

• You create the navigation tree by creating base categories, sub-categories (and if 
needed sub-sub categories). 

• Categories are sorted alphabetically. 

• Templates are sorted into the created navigation tree categories. 

Template Category/Navigation Tree 

As administrator you get right-click menus to create, rename, 
move and delete categories and sub categories in the tree. 

 

Note: A category must include at least one template for you to be 
able to save it. “Empty” categories are highlighed with warning 
symbols and will not be saved when the tool is closed. Se below. 

 

Note: Depending on tool configuration, you may only be able to 
make changes to templates created by your user role, including 
their place in the navigation tree. From this follows that you 
cannot move or delete a category that includes one or more 
templates created by another role  
(indicated by lock symbols). 

 
  

 

Template list, selected category 

As administrator you get right-click menus to move a selected 
template to a category. 

Buttons at the bottom of the list allow you to create, name and 
configure a new template and delete a selected template. 
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• Note: Templates that do not belong to a category are sorted into the category 
“Uncategorized templates”. This category is only visible when there are 
uncategorized templates. 

 

Add a navigation tree category or subcategory. 
 To add a root category: Right-click outside any category names in the tree. An Add 

Root Category menu shows. Select it. 

 
To add a subcategory: Right-click on the parent category and select Add on the 
menu. 

 

 A new “Category” name field shows in the tree. Enter the category name. Press return 
to save, and verify the resulting sorting order. 
 

Rename a category/ sub-category 
 Right-click on the category/template you want to rename and select Rename in the 

menu. The name field changes to edit mode. 

 

 Make the name changes. Press return to save, and verify the resulting sorting order. 

 

 

  



Traffic Studio Administrators Reference Manual 
 

Ver.25.7.(X)   47 /91  

 

 

 
 

 

Privileged 

Move a category or template to another category 
You can move a subcategory to another root category, or place it under a subcategory, 
making it a subcategory. Moving templates inside the navigation tree work the same way. 
 

• Note: In a system with “old”, uncategorized templates, you will have to categorize all 
templates by moving them from the “Uncategorized Templates” category to suitable 
categories in the tree. When no templates are uncategorized, the uncategorized 
category will be hidden. 
 

 Right-click on the category you want to move and select Move in the menu. 
Alternatively, right-click on a template in a category template list and select Move to 
Category. 

 

 Right-click on the root or subcategory you want to move the category to, and select 
Move [category/template name] to [target category name] in the menu. 

 

 

 

Delete a category or subcategory in the tree 

• Note: You can only delete categories created by the user role you logged in as. 
Categories created by other user roles are “locked”. 

• Note: Templates belonging to a category that is deleted will be moved to the 
“Uncategorized templates” category in the tree. 
 

Right-click on the category/template you want to delete and select Delete in the menu. 
The category will be deleted immediately.  
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Move all old locally/file stored text templates to the Uncategorized 
templates category 
 

• Note: SuperUser only 

 

When upgrading a system from the legacy locally stored text templates (found in the “Old 
type of templates” category in the navigation tree) to the database, there is a quick way of 
importing all old text templates to the Uncategorized Templates category. This way they 
will be available to all users of the roles you selected at import. (Of course, the templates 
can then be moved to other categories, see above.) 

• Note that old selection templates need to be moved manually, one by one. 

 

 In the navigation tree, check the number of old templates that are to be moved. (The 
number includes both text and selection templates.) 

 

 Click on the New button, the New template section will expand (and an Import 
button will show). 

 

 In the Roles menu, select the [user]role/roles that will have access to the moved text 
templates. 
 

• For information about how to use filter/multiple selection menus, see Chapter Fel! H
ittar inte referenskälla. 

 

 Click on the Import button. 

 

 Confirm in the dialogue. 

 
Now all the old text templates have been copied to the Uncategorized Templates 
category.  
 
If/when the old-style locally stored templates are deleted (which have to be done 
manually by the administrator), this category will no longer be presented in the 
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navigation tree. 
 

Create a New Template 
 

• A template is a “snapshot” of the current entries and selections in the New Traffic 
Changes tool. 

• If you create a new template with a Template navigation tree category selected, 
the template will be sorted into this category. (You can, of course, move the 
template between categories later, see description above.) 
 

 Fill in all the needed sections and selections in New Traffic Changes. You can, of 
course, make a template of a partially completed information ticket, leaving the rest 
to the template used to complete. 
 

 Click on the New button on the Templates tab. The bottom section will expand and 
show a name field,  a Cancel, and a Save button. 

 

 Open the Available by menu to set which roles will have access to the template. You 
can select all the roles you have access to yourself. 
 
The top selection is your logged-in user. Check this box to make a personal 
template available only to you. (When you check the top box all other users will be 
greyed out in the menu. Note that this is a configurable function, see the 
Administrators manual.) 
 
For information about how to use filter/multiple selection menus, see Chapter Fel! H
ittar inte referenskälla. 

 

 Enter a suitable Template name in the name field. 
 
Note: Templates are sorted in alphabetical order when the list is sorted by the 
Name column. If you want your templates in a specific order, start the name with a 
sorting number or letter, i.e. “1. Central Arena Main Event”… 
 

Tip: Try to standardize template names in your organization – this will make your 
work a lot easier…  
 

 

  Click on the Save button to save the template to the central system (in the selected 
category in the tree). 
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Edit a template 

• Note: Templates can only be edited and re-saved (with the same name) by users 
with the same user role as the creator of the template. 

 

 Select the template you want to edit/change. 

 Click on the Edit button. The rest of the template section will be greyed out. 

 

 Make the modifications in the information ticket component sections. 

 Return to the Templates section and click on the Save button. 

 Confirm the changes in the dialogue. 

 

Make a new template based on an existing template 
 Select and apply (Use) the template you want to “edit”. 

 Make the modifications in the information ticket component sections. 

 Return to the Templates section and click on the New button to create a new 
template from the current content. 

 If needed, change the roles that have access to the template (see above). 

 Enter a unique name and click on Save.  

 Sort the template into a suitable category, if needed. 
 

Delete a Template 

Note: The Delete button will only be active if a selected template was made by a user 
with your user role and the option Templates can be removed is ticked in Traffic 
Changes setup, see Appendix B. 
 

 Select the template in the list. 

 Click on the Delete button at the bottom of the tab window.  

 

 Confirm in the dialogue.  
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5.4 Yard Map Admin 

Tools > Yard Map Admin 

 

This simple tool allows you to administer yard maps (logical parking and charging maps). 
You can import, edit names, set the company access rights and delete maps as needed. 

All available maps are listed with basic information in a table, described below. 

 

Note: You will need to create a new map and delete the old one if you want to change the 
image file in a map, all other information and settings can be edited.  

 

 

 

 

 

 

Header Description 

ID Internal Map ID. 

Name Free text Map name, editable. 

Icons If map is to be visible to/selectable by users or not. See the 
“show” setting in the details section below. 

Created by User that imported map 

Created Timestamp showing when map was imported. 

Modified Timestamp showing when map settings/info was last edited. 

Modified By User that last modified map. 

System Instance Map system instance (only systems with multiple instances) 

 

  

List filters: Companies, free text 

Edit Map info 

Delete Map 

Download Map File to selected location 

Show/Hide 
Information Section 

Create New Map (row) 

Update 
Information 

Checkbox: 
Show/hide this 
map for users 

Menu: Givet hese 
companies access to 
the map 
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Create New Map 
To create a new map, click on the “New” button. The Information-section shows entry 
sections and menus for the new map. 

 

Note: You will need a correct .svg file with the parking locations on the map mapped to 
the corresponding chargers/connectors. Contact Consat to get assistance with producing 
such a file. 

 

Enter, from to top to bottom: 

 Name 

 Description 

 Upload map svg image file (browse and select file), see note above. 

 Choose if users are to see/have access to the created map (this can of course be 
changed later). Check box to let them see/select the map. 

 Choose the companies that shall have access to the map. 

 Click Save. 
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Edit Map 
To edit map information/settings, select the map row and click the edit button. 

Now you can edit name/description, user access (“show”) and company access. Click save 
to save changes. 

 

Download Map Image File 
To download the image file in/from a map, select the map row and click the download 
button, select the download location and click save. 

 

 

Delete Map 
To delete a map, select the row and click the remove button. 
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5.5 Vehicle User Interface – Runtime Page 

Vehicle Quick Menu > Vehicle User Interface – Runtime Page 

 

This quick menu item provides access to the vehicle system Runtime web interface. Here, 
you can access multiple system functions in the vehicle computer. It provides an 
interactive driver interface, displays, location map, simulator controls (for “driving” the test 
system), etc. 

 

Note: The Runtime page functionality description may be added in a later version of this 
document (or in a separate document).  
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6 Tool Configuration 
 

6.1 [Driver] Alarm 

File > Setup > Alarm 

In the alarm setup, you can select which sound to use when you receive a driver alarm. 
You can either select the default sound from the system or browse the path of the sound 
file of your choice. You can test your sound by clicking on the “play” symbol. 

 

 

 

 

 

 

 

Phone Number Listening 

• In the “Phone number Listening” section you can configure one or more phone 
numbers that a traffic controller can choose from when acknowledging the alarm. This 
number will get sent to the vehicle system and the vehicle system then silently 
(stealthily) calls this number and keeps the line open for audio monitoring of the front 
of the cabin through the driver microphone. 

• You can configure and name several telephone numbers that the traffic controller can 
choose from before acknowledging the alarm (and thus sending the number to the 
vehicle for call-up). 

• Also, see the corresponding chapter in the reference manual for a description of the 
function. 

 

Select Sound File 

Use either the standard system alert sound 
or select your own file (wav). 

Browse to the file, select it and pre-listen to 
it with the play-button. 

Phone Number Listening 

Check the box to enable the function. 

 

To add a phone number to the available 
numbers the traffic controllers can select, 
click on the Plus (add) button and enter 
number and name/description. 

 

To delete a number from the list, select the 
row and click on the minus (delete)-button. 

Alarm Functionality 

See the description in the below text. 

Save Changes 

… Or Cancel with the Cancel button. 
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Alarm Functionality Configuration 

• Two checkboxes allow you to configure the alarm functionality: Check “Show all 
Company Units (ignore responsibility)” to present alarms to the user from all vehicles in 
the system, regardless of the company they belong to.  
 
If this box is left unchecked, only alarms from the vehicles the user has responsibility 
for (i.e the vehicles listed in the My Vehicles tool) will be presented to the user. 
 

• Check “disable alarm at confirm” to request the vehicle to turn off the alarm when an 
operator confirms the alarm. The vehicle will then stop sending alarm updates and the 
alarm window will stop flashing red. The vehicle position and information will still be 
updated in the alarm window (just like when following the vehicle on the map). 
 
If the box is left unchecked the vehicle will continue to send alarm updates (with 
configured frequency) and the alarm window will still flash red after a user has 
confirmed the alarm. (The alarm sound will still stop after the confirmation and the 
alarm window will still be closed in the other operators' applications.) 

 

Click on Save to save your selection/configuration, or Cancel to exit without saving your 
changes. 
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6.2 Warnings 

File > Setup > Warning setups, indicated with   

In the various warning setups, you can enable/disable each warning and select if/which 
sound to play when the warning window is displayed in Traffic Studio. 

 

Warning setup windows: 

 

• Alcolock 

• Fire Alarm 

• [Vehicle] In service, no driver logged in 

• Vehicle Accident 

 

• Note that geofence-triggered Road limitation warnings are configured in the Geofence 
setup, see the next chapter. 

 

 Check box to enable function. 

 Browse to the sound file of your choice and click on Open in the navigation window. 

If no sound file is selected, a default system sound will be used. 

 Click on the play symbol button to play the sound. 
 

 

Click on Save to save your selection/configuration, or Cancel to exit without saving your 
changes. 
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6.3 Geofence 

The Geofence setup window allows you to select a notification/warning sound to be 
played whenever a vehicle triggers a geofence warning (presently limited to Road 
Limitation zones). The sound is played as the Road Limitation zone vehicle details popup 
is presented. 

 

• You can browse and select an audio file (.wav format) on your computer, and play it to 
verify your selection. Alternatively, enter the path to the file. Then click on Save. 
 
 
Note: You can disable triggering the Road Limitation Zone window when a vehicle 
enters such a zone and only enable the corresponding event for more subtle 
monitoring – See the Event Configuration and Event Monitor chapters in the 
Reference. 

 

 

 

 

 

 

 

 

  

Play (pre-listen to) the 
selected sound 

Browse to select audio file 

Click to open a browse windoe 
where you can navigate and select 
an audio file. The selected path is 
shown to the left. 

Enter/view path 

If you know the path to the audio 
file (or can copy it from windows) 
enter or paste it here. 

“Show vehicle violation 
window on road violations” 

Trigger the Road limitation zone 
warning window when a vehicle 
enters a limitation zone. 
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6.4 Assignments and Journey Start Time Setup 

File > Setup > Assignments and Journey Start Time 

 

 

 

 

 

  

 

 

Assignments Settings 

• Show Tow: Tick this box to include functionality for assigning Towed vehicle (tram). 

• Show manual assignments as popups: Ticking this box and clicking on Save will ensure 
that all manual assignments will be shown as popup windows in the lower right corner 
of the application. 

• Check Enable remove dynamic journeys to allow the user to delete/remove dynamic 
journeys [created from journey templates]. 

• Check Can deny manual assignments to enable the user to approve or deny manual 
assignments, i.e., assignments performed by the drivers themselves. (Notification and 
decision on a pop-up and in separate section in the Assignments tool.) 

• Check Journey activation time limit to turn off the activation function for on-demand 
journeys a set time before the planned journey start. (This makes it possible to avoid 
journey activations too close to the journey start for the drivers/organization to react.) 
Set the time [before the journey start] the activation is to be “locked” in the time 
window. 
 

Journey Start Time Settings 

Maximum time interval for changing a journey’s start time: This determines how 
much a journey’s start time can be modified. E.g., the time is 9.00 am and the value is 120 
minutes. The user can modify start times from 7.00 am to 11.00 am. 

Show journeys starting within the next: Number of minutes used to populate the list 
of incoming journeys. The user can also change the settings directly in the Journey Start 
Time plugin. 

Update refresh rate for shown journeys: This determines how often the list updates 
with new journeys. 
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6.5 Camera View (My Cameras) 

To set up the (web) cameras available to the user in the Camera View tool, you use the 
tool My Cameras. (Cameras are normally configured for whole roles/groups but can of 
course be set up for single users too.) 

Use this tool to add and name cameras, define their position and direction, and configure 
which stop points are in view (if any) – for camera access through the corresponding stop 
point shortcut menus. 

 

 

My cameras: Overview 
The tool lists all configured cameras, including the configured parameters and the number 
of stop points covered. Buttons for adding, deleting, and editing cameras are included. If 
you have many cameras the free text filter will help you quickly find a particular camera in 
the list. 

 

 

 

 

 

 

 

• Double-click on a row to zoom the map to the camera position. 

 

Column Description 

Camera The configured name of the camera 

Free-Text Filter 
(Camera and URL Columns 
only) 
 

 

Add Camera 

 
Edit Camera parameters, 
location 
 

 

Delete Camera 
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Column Description 

URL The URL of the web camera 

Longitude Location: Longitude 

Latitude Location: Latitude 

Camera Direction The direction of the camera, in reference to the map: ”0” is due 
north, ”-90” due west, ”90” due east… 

Stop Points The number of stop points covered by the camera (configured as 
being in the camera field of view). 
 
Note: The Stop point presentation is configured in the Tooltips 
and labels menu – see the User reference manual, chapter 7.2. 

 

Add a Camera 
To add a new camera to the list: 

 Click on the Add camera button. An empty edit (Add new) section will show below 
the camera list section. 

 

 In the Add new section: Enter a suitable camera name, the search path (URL), and the 
camera location: longitude and latitude (if available). If long/lat is not available but 
you can identify the location on the map, use the map location functionality instead, 
see below. Enter the camera direction and add stop points visible in the camera view, 
see descriptions below. 
 
Tip: If you lack exact information about the camera, you can often use the camera 
image to identify the location, direction, and covered stop points: Enter the camera 
name and URL and save the camera with the default location. Then select the camera 
in the Camera View tool to view the camera image. Edit the relevant parameters to 
complete the setup. See the following section about how to edit cameras. 
 

 

 Save the camera by clicking on the save button. 
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Enter/edit camera location using the map 
The correct coordinates of all cameras may not always be readily available. To enter a 
camera location using the map, both when setting up a new camera and when editing an 
existing camera, do like this: 

 Pan/zoom the map to show the area where the camera is located and make sure the 
map selection tool is set to Stop Point. 

 

 Click on the ”enter location using map” button. The button is dark grey when the 
positioning function is active. 

 

 Right-click and draw a (yellow) positioning rectangle on the map – the camera 
location will be at the Centre of the drawn rectangle. 
 

 When you release the mouse button, a preliminary camera location will be displayed 
by a grey camera symbol with a cogwheel overlay. If you are editing an existing 
camera, the current location will still be indicated by the normal camera symbol, see 
the example below. 
If needed, redo steps 3-4 until the position of the camera is correct (use the camera 
image for reference, see the tip above). 
 

 

 Proceed with entering the remaining parameters or save the location using the save 
button. 
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Add/remove stop points visible in the camera view 
 Make sure the ”enter location using map” button is not active (otherwise, click on it to 

deactivate the function) 

 

 If needed, pan/zoom the map to show the area where the camera is located and 
make sure the map selection tool is set to Stop Point. 

 

 Right-click and draw selection rectangles over the covered stop points. These are 
added to the Stop points list in the Add new/edit section. Repeat to add more stop 
points to the list. 

 

 To remove a stop point from the list, click on the remove button to the right of the 
stop point name. 

 
 

 Proceed with entering the remaining parameters or save the current parameters/stop 
points using the save button. 
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Edit camera [parameters, location] 
Editing cameras work just like setting up new cameras. The only difference is the name of 
the camera parameter section (Edit instead of Add new) and that parameters will already 
be entered in the various fields. 
 

 Open the Edit [parameters] section by clicking on the edit button on the 
corresponding camera row. 

 

 Change the needed parameters (see the previous sections for how to do this). 

 

 Save your changes by clicking on the save button. 

 

 

 

 

Delete Camera 
To delete a camera from the list, click on the delete camera button and confirm in the 
presented dialogue. 
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6.6 Customer Support 

File > Setup > Customer Support 

Disturbances and/or Text Announcements can be shown in a popup window in the lower 
right corner of the application when they become active. Tick the checkboxes to enable 
the popup window. 
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6.7 Drivers 

The Drivers setup window is as simple as can be, it only includes a single check box: 
Enable remote driver login. Check the box and click save to enable traffic controllers to 
right-click on a vehicle to log in/out a driver. Click on Save to save the setting. 
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6.8 Line Network 

File > Setup> Line Network Setup 

This tool displays a logical view of the vehicles and the stops in the network. Vehicles are 
represented by arrows and their size and colour indicate their deviation from the 
timetable. Users can zoom in on vehicles and stop points just like the Map tool. 

 

In the Line network setup window, you can add or remove network maps as well as 
configure those that will open when the application starts. The maps are linked to their 
respective system (see below). Several maps can be linked to each system (usually one 
for buses and one for tramways). 

 

 

 

 

 

 

  

Choose system 

Choose the central system 

Line network linked to 
the system 

List of the line network 
maps linked to the system 

AutoStart 

Tick this checkbox to open the Line network 
when the application starts. 

Show directory 

Click here to open the directory 
where the maps are located.  

Browse 

Click on the 
arrows to browse 
(if there is more 
than one Line 
network) 

Remove (x), Add (+) 

Select and click on X to remove a 
file.  

Click on the + symbol and select a 
file to add it. 

Save / Cancel 

Save or cancel the changes. 
Both choices will close the 
window. 
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6.9 Map 

File > Setup > Map 

 

You can configure the map work area as well as assign a map and a database to each 
central system. 

 

 

Parameters Description 

Select system Which central system the settings will apply to. 

MapInfo Workspace 
file 

Path to the map file. 

Map coordinate 
system 

Define the coordinate system used by the map. Choosing 
WGS84 will enable the Zone fields. 

Zone Selection of the current zone for the use of the WGS84 
UTM coordinate system. 
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6.10 Text Messaging 

File > Setup > Text Messaging 

 

• Note: To set up pre-defined messages for a role: Load the role, open the Send Text 
Message tool and create the needed messages/reply alternatives. See the reference 
manual for how to use the Send Message tool. 

 

Tab: Message Sound 
Select the sound/sound file to be played when a new message is received. 

 

Use system sound 

The default system’s exclamation sound file is used whenever a new message is received. 

Use selected sound file 

Select your sound file by browsing to its location on your computer or typing in the path 
to its location.  If the path is incorrect or the file is missing, no sound will be played upon 
the reception of a new message. 

Browse 

Open a new window to browse the location of your sound file. Click OK in the new 
window to finish your selection. The path to the file will appear in the textbox. 

 

Preview the system sound or the selected sound file 

Click on the icon  to play the selected sound. 

Save  

Save the new settings for the message sound. 

Cancel 

Close the window and discard all changes made to the Message sound setup. 
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Tab: Presentation 
• Tick the checkbox to activate/deactivate the option of showing new messages as 

popups. 

• Tick in the “Free texts enabled” box to make it possible to enter free text messages and 
add new reply presets. With the box unchecked, only existing replies can be used in 
text messages. 
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6.11 Traffic Deviation 

File > Setup > Traffic Deviation 

 

• Note: These settings relates to the extended version of the Deviations tool. 

 

Enable Create Deviation on Journey Change 
Check to configure generation of new deviation/deviations when traffic controller 
traffic change actions are selected in the TS journey quick menu. (Cancel Journey, 
Cancel Part of Journey, Short Run, Short Turn). 

 

Note: Short turn generates two deviations, one for the selected journey and one 
for the matching following “return” journey. 
 

• Check the box to enable deviation creation at traffic controller action. Click 
Save to save changes. 

 

User can set Deviation to Status Closed 
Check the box to allow the user to set the deviation to status closed and save the 
changes. This function is normally only activated for “administrative” traffic controllers that 
will close deviations after negotiating penalties etc. with the PTA. 

 

 

  



Traffic Studio Administrators Reference Manual 
 

Ver.25.7.(X)   72 /91  

 

 

 
 

 

Privileged 

6.12 Traffic Changes 

File > Setup > Traffic Changes 

 

New Traffic Changes and Traffic Changes have a shared setup menu. 

 

Tab: General 
On this tab, you find various tool functionality settings. Check the box for enabling the 
corresponding function, and uncheck to disable it. Click Save to save any changes. 
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Label Description 

Template tree can be 
edited 

The user can create, rename and delete template categories and edit the 
template navigation tree structure, including template sorting/category. 

Personal templates 
allowed 

The user can use/create/delete personal templates. 

(The user profile is added as a top selection alternative to the Available for 
menu when creating a new template.) 
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Label Description 

Allowed to 
change/delete 
templates created by 
another role 

The user can change/delete role templates created by another role. 

 

(Templates created by the same role can always be changed/deleted.) 

Templates only 
overwrite included 
task components 

Check this box if templates are to only overwrite the task components included 
in the template and leave any other content/settings untouched. This allows for 
applying several templates in a sequence with different components to “build” 
a task. 

If the box is not checked, templates will overwrite task components not 
included (in the template) with default setting/content, “resetting” these 
components for manual completion. 

Show Disturbance 
Description 

 

Display the window Description in the New Traffic Changes tool and allows the 
user to add a description. 

 

Preview Poltech sign 

 

Enable preview for Poltech LED signs. 

Preview Ferrograph 
sign 

 

Enable preview for Ferrograph signs. 

Check spelling 

 

Enable the spell-checking function in written messages. (Windows selected 
language.) 

 

Hide audio section… Check this box to auto-convert all text messages to audio announcements for 
on-demand audio (read-aloud buttons at the bus stops). The audio section will 
be hidden. 

 

Poltalk mode, hide 
audio channels 

Only available when “Hide audio section…” function is enabled, see above: 
Hides all audio channel buttons in the Communication Channels section in the 
New Traffic Information tool and distributes the converted files to Consat sign 
systems only. Uncheck to allow the user to distribute the converted audio to 
other channels also, like SIRI, etc. 

Only selected task 
component 
(disturbance, text, 
audio) sections are 
visible 

 

When this box is checked only the selected task component sections are 
visible in the New Traffic Changes tool. This enables a cleaner user interface, 
see the example below. 

Enable Create 
Disturbance in quick 
menu 

Enable “Create Disturbance” function in vehicle/block quick menus. Opening a 
new traffic information task with a disturbance for the specific traffic data 
node. 

Show Text 
Announcement 

Check to include the text announcement section in the New/Change Traffic 
Changes window. If unchecked, the user will not see the text announcement 
section and he/she will not be allowed to edit traffic changes with only text 
announcements. Traffic changes with mixed content can be edited but will not 
show any text announcement content in the editing window. Note that the 
user will then be able to change valid time and addressing, affecting the (not 
visible) text announcement. 

Always set To Be 
Reviewed flag 

All traffic information tasks created or edited by the user will be listed on the To 
Be Reviewed tab in the Traffic Changes tool. 
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Label Description 

Show To be 
Reviewed Tab 

Enable the separate “To be reviewed” tab in Traffic Changes, showing Traffic 
Controller disturbance tasks that have not been completed with information 
task components. 

Show indication 
when task is being 
edited 

Enable “task being edited” indication for all users whenever a user edits a task. 
Also enables a popup reminding that a task is already being edited by another 
user whenever a user selects “Edit” for such a task. 

Traffic Controller 
Mode… 

Locks (write protects) the New Traffic Changes/Traffic Changes windows – 
Traffic Controllers create Traffic Information tasks using the simpler Traffic 
Controller Actions. 

Traffic controllers can 
delete tasks 

Available when Traffic Controller mode is checked. Allow Traffic controllers to 
delete traffic information tasks. 

Show temporal 
conditions 

Activate the Valid Intervals section in New Traffic Changes, enabling 
individually scheduled periods for all included task components. 

Disturbance Activate scheduled active periods for disturbances 

Text Activate scheduled active periods for text messages 

Audio Activate scheduled active periods for audio announcements 

Show Directions Include the task component Directions. (For drawing and distributing map 
directions to drivers – and in future versions, walking directions to passengers.) 

Show Disturbance 
Details 

Activate the Disturbance Details section. In the current version, this section 
only includes functionality for creating a “moved stop point” disturbance, see 
Reference Manual. 
 
Note: This section is only used/activated in specific systems and cannot be 
active at the same time as  “Allow move stop point”, see below. 

Enable pick-up 
passenger 

Activate the “Pick up passenger” action that creates a corresponding 
information task. (Does not have to be enabled for the user to view such tasks 
in the Traffic Changes tool.). See the reference manual for the action 
description. 

Enable change of 
journey time 

Activate the “Change of journey timing” action that can “move” a journey or a 
section of a journey forward in time, to compensate for unplanned events. 

Note: System-specific function 

Enable forecast 
uncertain 

In “Change of journey timing” action: Activate the possibility of, instead of 
changing journey time (see above), flagging the particular journey forecasts as 
“uncertain”. 
(Enables the “Uncertain” checkbox in the Change of journey timing action 
window.) 

Note: System-specific function 

Enable Line-direction Include the Line-direction node in the Traffic data selection tree. 

 

Note: This functiuon is currently not fully supported in all parts of the systemn 
so it may be turned off by default. 

Show Selection 
Header 

Display the “Selection header” section in the Traffic Data Selection tool section. 
This section/field can be used as a header for template-based selection and/or 
as “ScopeAlias” section in systems where this is distributed to a third-party 
information system. Also, see the Reference manual for an explanation. 

Note: The setting controls if the section is to be displayed to the user. A 
header/ScopeAlias may be included in a template even if this section is not 
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Label Description 

displayed for the user. The function is then hidden for the user, an argument for 
keeping the section visible. 

 

Allow Move Stop 
Point 

Enable the “move stop point” function. (Which includes cancelling a stop point 
and assigning the traffic to an alternative, close by, stop point.) You can set a 
radius around the planned stop point to determine which alternative stop 
points shall be available to the users: 

 

Note: This function cannot be active at the same time as “Show Disturbance 
Details”, see above. 

Valid: Time – Traffic 
Data Selection 

Applicable when Traffic Data Selection is chosen in the Valid: Time section of 
the tool. 

These settings control how many minutes before the selected traffic data 
starts, and how many minutes after it ends the task/ticket is to be valid. 

For instance, how many minutes before a cancelled journey is the 
announcement telling the public about it to be triggered, etc. 

Templates Path to folder containing traffic information templates created in older system 
versions. (browse function to locate, select folder) 

These templates are displayed in the navigation tree in a separate category 
“Old templates. 

When these templates are no longer needed, delete the template files in the 
folder to clean up the navigation tree. 
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Section Enabling Settings, Examples 

 

 

 

 

 

 

Tab: Audio Announcement 
On this tab, you enable/disable the audio announcement function and define the available 
audio announcement repetitions and interval menu alternatives. 

Add (+) or remove (x) alternatives for the repetitions and interval menus in the two 
corresponding fields and then save your settings by clicking on Save.  

 

  

Only selected task component sections 
visible: No components selected 

When no task components are selected in the New 
Traffic Changes tool the description and valid time 
sections are greyed out. The text and audio 
announcement sections are hidden. 

 

Only selected task component 
sections visible: Disturbance 
and Text announcement 
selected 

All sections but the audio 
announcement section, are displayed. 

Only selected task 
component sections 
visible: All task 
components selected 

All sections are displayed. 
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Audio announcements disabled 

When you uncheck the Use Audio Announcement checkbox your New Traffic Changes 
tool will have the Audio Announcement tool functionality removed, see image. In a system 
that includes the audio announcement functionality, you will still be able to see audio 
announcements created by other users with the function enabled. 

• Note: Systems that use text-to-speech auto conversion but have the audio 
announcement section in the user interface hidden (the “Hide audio section..” box on 
the General Tab enabled) must still have “Use Audio Announcements” enabled. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Use audio announcement 

Enable/disable audio announcement function 

 

Repetitions: Select, define 
menu 

Select the amount of times the 
message will be repeated. You 
can edit an existing number or 
add/delete rows. 

 

Intervals: Select, define 
menu 

Interval in seconds between the 
repetition of the message. You 
can edit an existing valueor 
add/delete rows. 

 

Delete selected row 
(menu item) 

Select a row and click 
on the red X to delete 
that menu alternative. 

 

Add row (menu item) - to end of 
menu list 

Click on the + button to add a row to the list (it 
will have the default value 0, enter a value and 
the row will be sorted into correct position in 
the menu list. 

 

Save changes 
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Tab: Communication Channel (Groups) 
Communication Channel Groups determine the Channels available to the users. 

(See the separate project documentation for your particular communication 
channels/API:s, and what each individual “channel” covers). 

 

• Note: This function can be enabled or disabled, depending on customer/user needs. 
Check the Enabled box to enable, and un-check to disable the function. When disabled 
the corresponding Communication Channels field will be hidden in the New Traffic 
Changes tool window. 

 

 

 

When enabled, you can define and name the communication channel “group” alternatives 
available in the New Traffic Changes tool using two simple lists. Each named, selectable 
communication channel group in the left list is mapped to one or more communication 
channels/API: s in the right. 
 

 

 

 

 

 

 

 

 

 

 

Channel Groups 

All created channel groups. These 
are the checkbox alternatives 
available in the New Traffic 
Changes tool. 

Select a group to view/edit the 
mapped channels. 

 

Channel 

All available communication 
channels, through which 
disturbances/announcements are 
published. 

Check corresponding box to map 
one or more channels to selected 
group in left list.  

 

Name, Create, delete 

Enter the name of a new group in the 
name field. Press “+” to add new group. 

Select and press “-“ to delete group. 

 

Enabled 

Check/un-check to enable/disable 
the Communication Channel 
functionality 

Header Required 

Check to require a header for 
messages distributed over this 
channel group (indicated in the 
Traffic Changes tool section.) 
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Create a Communication Channel Group 

 Type the name of your new communication channel in the name field. 

 

 Check the boxes of the channels you want to include in your group. 

 

 Click on Save to save your new group. 

 

 

Delete a Communication Channel Group 

 Select the communication channel group you want to delete. 

 

 Click on the delete button, the group will be deleted from the list. 
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 Click to save your changes. (If you click on Cancel the window will close without 
changes i.e. the deletion will be undone.) 

 

 

Edit communication channels in a group 

 Select the group in the list 

 Check/un-check channels to make the desired changes 

 Click on Save to save your changes 
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6.13 Tiled Map 

File > Setup > Tiled Map 

  

 

 

 

 

 

 

 

Parameters Description 

Latitude Starting position of the map: Latitude (check/adjust using map 
window) 

Longitude Starting position of the map: Longitude (check/adjust using 
map window) 

Zoom Desired default zoom level (check/adjust using map window) 

Tile Server IP address to the server where the map can be locally saved. 
Click on the reload button to load and verify the position/zoom 
level. 

 

Note: This parameter can be left empty if the map is retrieved 
from the standard source on the internet. 

 

 

Note: The Map Cache Validity Timeout can be configured: 

<plugInVariable d2p1:name="FileCacheTimeout" d2p1:value="7.00:00:00" /> 

  

Start Position, zoom level presented on map 

Check the start position and zoom level set with the 
controls to the left with this map window.  

 

Reload Map 

Click to (re-)load the map (and 
cache the corresponding tiles 
for fast presentation). 

Drag to set starting point 

You can set/adjust the start 
position both by entering the 
longitude and latitude 
numerically in the fields to the 
left, and by dragging the map. 

Menu: Select System (available to user) 

Select central system to view corresponding map. 
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6.14 Voice Communication 

File > Setup > Voice Communication 

 

Note: The Voice Communication tool is configured both using a configuration file 
delivered to each customer by Consat Telematics and with the Voice Communication 
setup window in Traffic Studio, described below. 
 
The two complement each other allowing for quick changing of basic settings in the setup 
window, and a very detailed configuration of each used message/status code, etc. in the 
file. 

 

The setup window is divided into separate sections for: 
 

• Communication (two tabs let you set up a primary and secondary communication 
system) 

• Audio Signals 

• Logging and debugging 

• User Interaction 

• Sound Files and Utilities and  

• Traffic Control. 

 

 

 

 

 

 

 

 

 

Communication 

View/select Network Type, Ports etc. 

Here you can also browse and validate the 
configuration file with all configuration settings. 

Primary/Secondary Network Communication Setup 

 

Audio Signals 

Alarm, Warning and incoming Call (Request) sounds. 

Activate (check box), use default (leave browse fields empty) or 
browse and select audio files. Play current sound with 
corresponding Play button.  

Logging and Debugging 

Browse the Log file Directory 

User Interaction 

Traffic Control 

Responsibility and traffic control related settings. 
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Communication (Primary/Secondary Network) 
On the two Communication network tabs, you configure network type, hardware, 
communication settings etc. as well as features/functions like SMS generation (see table 
below). The primary and secondary network tabs are identical and they use two separate 
configuration files. 

 

 

 

 

Setting Description 

Network Type The type of communication network: CTS (Consat) IP-based, Tetra, 
Rakel, etc. 

 

Note: With Västtrafik Rakel selected, you can also choose to use IP 
signalling (communication with Västtrafik Telefonboken) instead of 
signalling/communicating with this system over Rakel, see 
screenshot below. Check the IP signalling checkbox. 

 

With IP Signalling selected, it is possible to enable [Rakel] signalling 
fallback should the IP connection be lost. 

This will tax the Rakel network, but at least one station at every 
traffic control site should have fallback enabled so as not to lose 
functionality if the IP connection is lost. 
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Setting Description 

Modem Type 

 

Select modem/radio transceiver type. Specific types generally offer 
deeper integration but a General radio unit is also supported with 
limited functionality. 

Select No Carrier Connected for allowing full tool functionality, 
minus voice communication (talking/listening). 

Select External (Cxe) to use the Consat Voice communication app 
instead of a modem connected to the computer. (Consat IP-based 
network selected in menu above.) 
 

This selection adds the Phone Link tab to the Communication 
section: 

 

DNS: Supplied by Consat 

Port: Supplied by Consat 

Phone Id: Check “Automatic” to automatically generate the phone ID 
(default setting). Uncheck to manually enter the ID (supplied by 
Consat). 

Phone Pin: Security PIN code, not yet supported. With “Automatic” 
unchecked, the PIN can be manually entered (supplied by Consat). 

Quick Connect (QR code): This lets you connect the phone by 
reading the QR code. Also displayed in the Voice Communication 
tool when External (Cxe) is selected as the modem and the phone 
(app) is not yet connected. 

Play Store (QR code): A QR code link to the Consat Voice 
Communication app on Google Play Store. (App only available for 
Android as of now.) 

Port Select port and speed, depending on the hardware used.  

Secondary Port 

 

A secondary port is configured for radio-based systems/networks 
that use two radio units. 

Note! If a fixed port is already configured in the configuration file 
that configuration overrides the setting in the Setup window (which 
will have no effect)! 

PTC 
Configuration 
File 

Define where the Network specific configuration file is placed. 
Browse it and verify that it is correct and that the tool can reach it 
with the adjacent Browse/Verify buttons.  

Supports SMS 

 

When this box is checked an SMS is sent to a phone number (in the 
configuration file) when configured messages/call requests are 
received. 
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Setting Description 

No Answer: 
Text 

 

Here the SMS text message sent when Calls are unanswered is 
defined. For example ”Call:”. 

Request Auto 
Answer 

When checked the vehicle systems are requested to automatically 
open calls, without the driver needing to pick them up. 

Simulation 
Mode 

 

When checked the tool is in simulation mode and no calls are 
opened. This mode is available for training and demonstration 
purposes. 

Handle External 
Telephone 
Number 
Requests 

Customer Specific Function 

Remote 
Control 

Allows TS Voice Communication tool to remotely control specific 
vehicle radio functions. 

Current functionality allows TS users to turn off an active driver 
radio alarm (that locks the radio in transmit state). 

An alarm off button is added to the Voice Communication tool. This 
turns off the active alarm state enabling the radio to receive 
incoming calls again. 

Auto Prefix Adds configured prefix number to call numbers entered in the TS 
Voice Communication tool. The right numerical field sets the 
number of digits the user enters to dial the number. In the example 
setting below, the user only enters tree digits, and the tool adds the 
prefix before making the call. 

 

 

Status code configuration in the configuration file 
In the configuration file, apart from configuring ports, groups etc. for each needed 
message status code used by the communication system, the following functions can be 
configured: 

 

• Name in GUI 

• Priority in Voice Communication tool queues 

• Call and/or Information queue presentation 

• Show as Alarm (Y/N) 

• Remove from the queue at Call up (remove call request…) 

• Colour coding in GUI 

• Indication/Warning sound (Y/N) 

• Alarm sound (Y/N) 

• Forward as SMS 

• Alarm priority level 

• Description 
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Audio Signals 

 

 

Setting Description 

Alarm (Radio) Activate sound by checking the box.  

Note: Leave the field empty for default sound (play sound with the 
Play button). 
 
Custom sound: Define the location, browse and click Play to verify 
a custom Alarm sound file. 

Warning Activate sound by checking the box.  

Note: Leave the field empty for default sound (play sound with the 
Play button). 
 

Custom sound: Define the location, browse and click Play to verify 
a custom Warning sound file. 

Incoming call Activate sound by checking the box.  

Note: Leave the field empty for default sound (play sound with the 
Play button). 
 

Custom sound: Define the location, browse and click Play to verify 
a custom Incoming Call notification sound file. 

 

Logging and Debugging 
 

 

 

Setting Description 

Directory for Log 
Files 

Define the location and browse the log file 
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User Interaction 

 

 

 

Setting Description 

Enable NumPad 
commands 

(Default: Checked) When this box is checked the keyboard 
commands described in the manual control the tool. When the box 
is not checked the keyboard function keys are used for control (see 
separate documentation). 

Autoset 
NumLock 

Numlock must be active for NumPad commands to be used. This 
setting allows for automatic Numlock when the tool is active. 

Show command 
buttons 

Check to include command-/Function buttons in the tool window, 
complementing the keyboard control. Uncheck when you do not 
want the tool to include these buttons. 

Application wide 
keys 

Check to make the command keys always active, regardless of 
which tool is selected in Traffic studio. If unchecked the command 
keys are only active when the Voice Communication tool is 
selected. 

  

 

Traffic Control 

 

Setting Description 

Number Control Center number 

Description Control Center name (free text description) 

Show all 
Company Units 
(ignore 
responsibility) 

Checked box: All vehicles in your own company are listed and 
available, regardless of responsibility. 

Unchecked box: Only vehicles in your own company, under your 
current responsibility are listed and can be called. 

Communicates 
with all vehicles 
(ignore traffic 
control) 

Checked box: Allowed to call all vehicles in the whole system, 
including those from other companies. If the box is unchecked only 
own vehicles are listed and can be called. 
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Setting Description 

Filter incoming 
requests on 
selected line 
group 

Checked box: Filter incoming call requests depending on the 
current Line Groups filter setting. 

Unchecked box: Ignore Line Groups filter. 

Broadcast to 
vehicle 

Enable “broadcasting” to a selected vehicle, not only vehicle 
groups. See reference manual. 
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6.15 Vehicle User Interface 

File > Setup > Vehicle User Interface 

 

The settings for Vehicle user interface access include enabling direct access over the 
local network (communicating directly with the vehicle computer to access the interface) 
and alternative/complementary access through the Software Configuration Manager. 

 

• Note: The Port and Connect Port settings are only used in specific installations. These 
fields are left empty by default. Consat will assist when setting up such specific 
systems. 
 

• Check the “Local network (Direct)” box to enable direct communication with vehicle 
computers connected to the local network, like test systems, etc. 
 

• Check the ”Runtime page” box to enable access to the vehicle systems (on the local 
network) runtime page. 
 
 

• Depending on system installation, you may need to enter Host and Path information for 
accessing the Configuration Manager. See below. 
 

• Check the ”HTTP” box to use HTTP instead of HTTPS (default) when accessing the 
Configuration Manager 

• Check the ”Vehicle User Interface” box to enable user interface access through the CM. 

• Check the ”Node Page” box to enable quick menu access to the software configuration 
manager node page of the vehicle. 

 

  

 

• Click on the “Save” button to save your settings/changes. 

Settings: driver interface – direct access over local 
network. 

Settings: Configuration manager access tool, driver 
interface through Configuration manager. 


